Note: This document is available at: http://www.accessmvp.com/TWickerath/downloads/accesslinks.zip
This copy last updated on May 15, 2014.
Naming Conventions

    Special characters that you must avoid when you work with Access databases

    http://support.microsoft.com/kb/826763
    Commonly used naming conventions

    http://www.mvps.org/access/general/gen0012.htm
    http://www.xoc.net/standards/default.asp → http://www.xoc.net/standards/rvbanc.asp#Access 

    Using a Naming Convention

    http://msdn2.microsoft.com/en-us/library/aa164529(office.10).aspx
Reserved Words
   Problem names and reserved words in Access

   http://allenbrowne.com/AppIssueBadWord.html
    Reserved Words in Microsoft Access


List of reserved words in Jet 4.0
    http://support.microsoft.com/kb/286335

http://support.microsoft.com/kb/321266



    ANSI-92 Reserved Words




ODBC Reserved Words

    http://support.microsoft.com/kb/287417

http://support.microsoft.com/kb/125948
    SQL Server Reserved Words

    http://msdn.microsoft.com/en-us/library/ms189822.aspx
Database Design

You should spend some time gaining an understanding of database design and normalization before attempting to build something in Access (or any RDBMS software for that matter). Here are some links to get you started.  Don't underestimate the importance of gaining a good understanding of database design.  Brew a good pot of tea or coffee and enjoy reading!

   http://www.accessmvp.com/JConrad/accessjunkie/resources.html#DatabaseDesign101
    (See the first download titled "Understanding Normalization")

<Begin Quote  (from page 22 of document)>

"The most important point for you to remember is that you will always re-introduce data integrity problems when you de-Normalize your structures! This means that it becomes incumbent upon you or the user to deal with this issue. Either way, it imposes an unnecessary burden upon the both of you. De-Normalization is one issue that you'll have to weigh and decide for yourself whether the perceived benefits are worth the extra effort it will take to maintain the database properly."

<End Quote>

As fellow Access MVP John Vinson likes to say "Storing calculated data generally accomplishes only three things: it wastes disk space, it wastes time (a disk fetch is much slower than almost any reasonable calculation), and it risks data validity, since once it's stored in a table either the Total or one of the fields that goes into the total may be changed, making the value WRONG."

Also recommended: Find the copy of Northwind.mdb that is probably already installed on your hard drive. Study the relationships between the various tables (Tools > Relationships...)

Best Practices

    How to keep a Jet 4.0 database in top working condition

    http://support.microsoft.com/kb/303528
In particular, follow the three links:

    Verify that the latest operating system service pack is installed

    Verify that the latest Microsoft Jet service pack is installed  and

    Verify that the latest service pack for your version of Office is installed
Also recommended: Install the latest version of MDAC (Microsoft Data Access Components)

http://www.microsoft.com/downloads/details.aspx?FamilyID=6c050fe3-c795-4b7d-b037-185d0506396c&DisplayLang=en




Name AutoCorrect
Name AutoCorrect was introduced with Access 2000. This is a buggy feature. I recommend always deselecting the options to track & perform corrections via Tools > Options  ---> General Tab.  Unfortunately, these options are selected by default in all new databases, so you should remember to always deselect it. For more information, see the following article: 

    Failures caused by Name Auto-Correct
    http://allenbrowne.com/bug-03.html
References
    Solving Problems with Library References (Allen Browne)

    http://allenbrowne.com/ser-38.html



    Access Reference Problems (Doug Steele)
    http://www.accessmvp.com/djsteele/AccessReferenceErrors.html
Defining relationships between tables
    http://support.microsoft.com/kb/304467
Locking Database File

    Introduction to .ldb Files

    http://support.microsoft.com/kb/299373
Slow network performance

    BUG: Slow performance on linked tables in Access 2002 and Office Access 2003

    http://support.microsoft.com/kb/275085
    Slow performance when user opens an object with Name AutoCorrect enabled in Microsoft Access

    http://support.microsoft.com/kb/290181
Some good web sites

Albert Kallal’s site





http://www.kallal.ca/
Alex Dybenko’s blog




http://accessblog.net/
Allen Browne's tips for Access users

http://allenbrowne.com/tips.html

Arvin Meyer’s Datastrat site



http://www.datastrat.com/
Bill Mosca’s “That’ll do-it site”:


http://www.thatlldoit.com/Pages/default.aspx
Database Answers (DB Designs)

http://www.databaseanswers.org/data_models/index.htm
Danny Lesandrini’s site




http://www.databasejournal.com/features/msaccess/
Doug's pathetic Microsoft Access page
http://www.accessmvp.com/djsteele/AccessIndex.html
   Note: Make sure to check out Doug’s past Smart Access articles: http://www.accessmvp.com/djsteele/SmartAccess.html
FMS Tips and Techniques page


http://www.fmsinc.com/free/tips.html#TipsforAccess
Gunter Avenius’ page




http://www.avenius.de/en/  (Ribbon expertise)
J Street Technology (Armen Stein)

http://www.jstreettech.com/downloads.aspx
Roger’s Access Library




http://www.rogersaccesslibrary.com/
Seattle Access downloads



http://www.seattleaccess.org/downloads.htm
Stephen Lebans site (retired content):
http://www.lebans.com/
Tony's Main Microsoft Access Page

http://www.granite.ab.ca/access/

The Access Junkie





http://www.accessmvp.com/JConrad/accessjunkie/resources.html










http://www.AccessJunkie.com   ((Primarily Access 2007/2010/2013)
The Access Web





http://www.mvps.org/access/
Walter Niesz's Link Library



http://www.utteraccess.com/wiki/index.php/Links
Wayne Phillips “Everything Access”

http://www.everythingaccess.com/tutorials.asp
Google Groups
https://groups.google.com/forum/#!forumsearch/microsoft.public.access
Google advanced search of Microsoft Support site
Newsgroups

“Microsoft Answers site”:
 http://answers.microsoft.com/en-us/office/forum/access
MSDN:

 



 http://social.msdn.microsoft.com/Forums/en-US/accessdev/threads
Windows Secrets Lounge:
 http://windowssecrets.com/forums/forumdisplay.php/14
Causes of Corruption

    Preventing Corruption (Allen Browne)
    http://allenbrowne.com/ser-25.html
    Corrupt Microsoft Access MDBs FAQ (Tony Toews)

    http://www.granite.ab.ca/access/corruptmdbs.htm
Recovering from table corruption

1. Select the table that has the corrupted record(s).
2. Copy the table (Ctrl C). Paste the structure only of this table into a new table name (Ctrl V).
3. Select the original table again. Click on File > Export...  In the Save as type dropdown, choose Text Files (*.txt; *.csv; *.tab; *.asc). Use the option to export as delimited. Use a comma as the delimiter, and place a check in the Include Field Names on First Row.
4. Open the new table. Attempt to import the data from the .csv text file that you saved earlier. If all goes okay, you can delete the original table, and re-establish relationships to the new table.
Note that if you used an autonumber field, then you may need to first restore to a long integer, and then use an append query to append the records to yet another new table, in order to restore the correct autonumber values. Here are a couple of Microsoft KB articles for methods on dealing with table corruption:
    How to recover data from a damaged database table or a corrupted 

    database table in Access 2000, Access 2002 or Access 2003

    http://support.microsoft.com/kb/247771
 

    How to Recover Data from a Corrupted Table by Using the DAO Method

    http://support.microsoft.com/kb/815280
My standard advice for attempting to fix minor corruptions:

First, make a back-up copy of your database, if you have not already done so. Try opening your database using the undocumented /decompile option. If you only have one version of Access installed, you can click on Start | Run, and enter:   msaccess /decompile 
The next database that you open will have it's compiled VBA code discarded. Open the suspect database while holding down the Shift key the entire time, to prevent any startup code from running (and thus attempting to compile). If you have more than one version of Access installed, create a shortcut whose target points to the full path of the version of msaccess.exe, with this optional switch included. For example:  

      "C:\Program Files\Microsoft Office 2003\OFFICE11\MSACCESS.EXE" /decompile

After opening the database, do a compact and repair, again holding down the Shift key. Then open any code module and compile your VBA code (Debug > Compile ProjectName). If this does not fix your database, continue on with the next paragraphs.

Create a brand new database and immediately disable the Name Autocorrect feature (see: http://allenbrowne.com/bug-03.html for reasons why you want to do this). Then import all objects from the suspect database into the new database, one group at a time. In other words, import all tables (but not linked tables), then import all queries, then all forms, etc. When importing local tables, it is a good idea to click on the Options >> button and check the options to import relationships (unless you suspect corruption in a relationship), along with Menu/Toolbars and Import/Export Specs. If any of the objects in the source DB are hidden, you'll need to first unhide them. While Access will allow you to import all objects in one operation, the experts at FMS, Inc. (a Microsoft Partner), have stated that it is best to import objects one group at a time (Reference: http://www.fmsinc.com/ubb/Forum12/HTML/000285.html).(5/15/2014: Need to find new link
Recreate any linked tables from scratch using File | Get External Data | Link tables...  Access can cache a lot of information about linked tables, which may no longer be valid, so it's always best to recreate the linked tables from scratch. You will need to set the checked references to match the source database, along with any startup options set under Tools > Startup. Going through this process often times solves corruption problems, because you get a new set of the hidden system tables (the tables whose names start with "MSYS"). These system tables are updated appropriately as you import objects.

This may sound like a lot of work, but it really isn't. Creating a new container DB, disabling Name Autocorrect, importing all objects one group at a time, re-establishing any linked tables, setting startup options, and setting references to match the source DB is usually a fairly quick procedure. When you are in the Visual Basic Editor, in order to check that the references match the source DB, you should do a Debug > Compile ProjectName as well.

Articles written by me
    ADO and DAO Library References in Access Databases
    http://www.accessmvp.com/TWickerath/articles/adodao.htm
    Combo box to find a record
    http://www.access.qbuilt.com/html/find_a_record.html
    Conditional Formatting

    http://www.access.qbuilt.com/html/conditional_formatting.html
    Crosstab Queries
    http://www.access.qbuilt.com/html/crosstab_queries.html
    Gem Tips
    http://www.access.qbuilt.com/html/gem_tips.html

    

    Always Use Option Explicit

    http://www.access.qbuilt.com/html/gem_tips.html#VBEOptions
"However, every experienced developer knows that the failure to use the Option Explicit statement to force explicit variable declaration is a coding blunder of the highest order. Using undeclared variables can introduce subtle, hard-to-find bugs into your code that are easily avoided by using this one, simple technique."


http://www.access.qbuilt.com/html/gem_tips.html#AutoIndex

http://www.access.qbuilt.com/html/gem_tips.html#ToolbarBtns
    How to print only one page of a multipage report

    http://www.access.qbuilt.com/html/reports.html#PrintOnePgOfRpt
    Displaying Subtotals and a Grand Total on a Form That Displays a One-to-Many Relationship
     http://www.access.qbuilt.com/html/subtotals.html
    Update Front End
    http://www.access.qbuilt.com/html/update_front_end.html
    Note: These days, I use the above method only as a last resort, when a client simply cannot or will not 

              accept using a tool designed for this purpose. I use the AutoFEUpdater tool when possible.
    Implementing a Successful Multiuser Access/JET Application

    http://www.accessmvp.com/TWickerath/articles/multiuser.htm
    Dealing with the Trust Center (Access 2007)

    http://www.accessmvp.com/TWickerath/articles/trust.htm
Other QBuilt URL's
    Cannot make .MDE

    http://www.access.qbuilt.com/html/conversion.html#CannotMakeMDE
    VBA tips: 

    http://www.access.qbuilt.com/html/vba1.html
    Split the Database

    http://www.access.qbuilt.com/html/gem_tips1.html#SplitDB
    Why Social Security Numbers should not be stored in an Access database

    http://www.access.qbuilt.com/html/security.html#DoNotStoreSSNs
    Creating A Customized Login Screen For A Secured Database

    http://www.access.qbuilt.com/html/custom_login.html
    How to compact the current database automatically when it reaches a certain size.
    http://www.access.qbuilt.com/html/vba1.html
Find and Replace Utilities

    Find & Replace: http://www.rickworld.com/products.html
    Speed Ferret: http://www.moshannon.com/speedferret.html  
         Note: Unfortunately, Speed Ferret has never been updated past Access 2002 / SQL Server 2000 
    V-Tools:
 http://www.skrol29.com/us/vtools.php    (Free)
Wizards not working
Try the following steps. You possibly have other wizards that are not functional as well. Replace three files on your hard drive, Acwzmain.mde, Acwzlib.mde and Acwztool.mde, using the instructions shown in KB 303769. One or more of these files may have become corrupted. Do this without Access running.

    http://support.microsoft.com/kb/303769 

    http://support.microsoft.com/kb/833220   ( Error in loading DLL

1.) Insert the Microsoft Office or Access compact disc.

2.) By using Windows Explorer, open the Pfiles\Msoffice\Office\1033

     folder on your CD-ROM or DVD-ROM drive, and locate the

     Acwzmain.mde, Acwzlib.mde and Acwztool.mde files.
3.) Select these files, and then click Copy on the Edit menu
4.) Open the folder that you installed Office into. The default folder is 

     C:\Program Files\Microsoft Office. Select the Office\1033 folder, 
     and then on the Edit menu, click Paste.


If that doesn't fix the problem, try re-registering the Accwiz.dll, Msado15.dll and DAO360.dll files. 

Click on Start > Run. Then enter the commands:

    Regsvr32 Accwiz.dll
    Regsvr32 "C:\Program Files\Common Files\system\ado\Msado15.dll"
    Regsvr32 "C:\Program Files\Common Files\Microsoft Shared\DAO\Dao360.dll"

Wizard starts, but “No valid fields can be found” error message may be related to overly aggressive settings on antivirus software:

http://groups.google.com/group/microsoft.public.access.tablesdbdesign/browse_frm/thread/287b312d799c6739/2543458dbca8ddde
and   http://alexdyb.blogspot.com/2006/02/be-careful-with-kaspersky-anti-virus.html
Access 2003 Users:

    BUG: List of currently linked tables may not appear in 
    Linked Table Manager Wizard in a database in Access 2003
    http://support.microsoft.com/kb/835519
Notes:

1. To find Accwiz.dll in Win. XP Professional, I had to make sure to place a check on Advanced Options in the search dialog, with Search system folders and Search Subfolders checked.

2. Although I received a message indicating success, when using regsvr32, I found that the path was not updated. I had to manually update the value of this key on my PC.

All kinds of weird errors found when msjtes40.dll is not properly registered

Start > Run | Enter:   regsvr32 msjtes40.dll

    FIX: When you create a database or a table, an error occurs and 
    Access unexpectedly closes in Office Access 2003 or in Access 2002
    http://support.microsoft.com/kb/905530
Access has encountered a problem and needs to close. 

Workgroup Administrator couldn't create the workgroup information file. Make sure you have specified a valid path and file name, that you have adequate permissions to create the file, and you have enough disk space on the destination drive. (-3100)

Microsoft Access could not find the file: File Name
Database Bloat
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    Database bloat is not stopped by compacting database with Access 2002 format
    http://support.microsoft.com/kb/810415
To reveal which workgroup information file you are currently joined to:
? application.DBEngine.SystemDB    or 

? DBEngine.SystemDB  (shorthand)

· C:\Program Files\Microsoft Office 2000\Office\SYSTEM.MDW
Splitting Name Data

I have a table that has a field called FullName.  I want to separate FullName into 3 fields LastName, FirstName, MiddleI.  The last name, first name and middle initials are separated by one space.

 

One of my favorite utilities for splitting names in Access is called "Splitter for Microsoft Access". If you don't mind popping $39 for a copy, you will have a very good utility that can untangle the messiest name data:
http://www.infoplan.com.au/splitter/

A very easy method to use involves exporting the table to Excel. From within Excel, use Data > Text to Columns...   Then re-import your table back into Access.

You can also create the new fields in the table and then use an update query to populate the new fields. The update query would look like this:

Field: LastName
Table: Your tablename
Update To: SplitName([FullName],0)

Field: FirstName
Table: Your tablename
Update To: SplitName([FullName],1)

Field: MiddleInitial
Table: Your tablename
Update To: SplitName([FullName],2)

Create a new standard module. Then copy and paste the following function into it. This will create a zero-based array named strResult. The On Error Resume Next statement will prevent the function from choking to a halt if there is no middle name for a given record.


Public Function SplitName(FullName As String, _
       intElement As Integer) As String
On Error Resume Next

Dim strResult() As String
strResult = Split([FullName], Chr(32))
    
SplitName = strResult(intElement)

End Function
________________________________________________________________________

Update: 5-Nov-2006 for Name data in the format:  LastName, FirstName MI

(i.e. comma in-between Lastname and Firstname, but a space in-between Firstname and MI. In this case, the user did not want to retain the middle initial).
http://groups.google.com/group/microsoft.public.access/browse_frm/thread/aae22c59e5d218eb/8168efa560d04200
Field: LastName 



Field: FirstName
Table: Your tablename 



Table: Your tablename
Update To: SplitName([Name],Chr(44),0) 
Update To: SplitName([Name],Chr(32),1)

Option Compare Database 
Option Explicit
Public Function SplitName(strFullName As String, _ 
         strCharCode As String, intElement As Integer) As String 

On Error Resume Next 
Dim strResult() As String 

    strResult = Split([strFullName], strCharCode)

    SplitName = strResult(intElement) 

End Function 

Misc.

    How To Handle Quotes and Pipes in Concatenated SQL Literals

    http://support.microsoft.com/kb/178070
    Using TIFF image files with Access 2003

    http://www.lebans.com/loadjpeggif.htm
    Using a wan with ms-access? How fast, how far?
  http://www.kallal.ca/Wan/Wans.html
    PRB: Jet 4.0 Row-Level Locking Is Not Available with DAO 3.60

    http://support.microsoft.com/kb/306435
    Copy layout of relationships window
    http://www.trigeminal.com/lang/1033/utility.asp?ItemID=12#12
    http://www.lebans.com/saverelationshipview.htm
Access related registry keys in 64-bit versions of Windows:

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Jet\4.0 

Validation Rules

Question posted in the newsgroup microsoft.public.access:  I am trying to create a validation rule that allows only two letters and ten numbers but do not seem to be having much luck.

Answer provided by “Chris O’C”:

     LIKE "[A-Z][A-Z][0-9][0-9][0-9][0-9][0-9][0-9][0-9][0-9][0-9][0-9]"

     Limit the field size to 12.

     Validation Rules (Allen Browne)
  http://allenbrowne.com/ValidationRule.html
International Dates in Access

    http://allenbrowne.com/ser-36.html
To reveal all linked paths:

SELECT Left(Database,255) AS [Linked Databases], 

Count(MsysObjects.Database) AS [Number of Tables]

FROM MsysObjects

WHERE (MsysObjects.Type)<>9

GROUP BY Left(Database,255)

HAVING Left(Database,255) Is Not Null;
If you want to see each table name, use this instead:

SELECT Left(Database,255) AS [Linked Databases], Name, ForeignName

FROM MsysObjects

WHERE (((MsysObjects.Type)<>9))

GROUP BY Left(Database,255), Name, ForeignName

HAVING (((Left([Database],255)) Is Not Null))

ORDER BY Name, ForeignName;
Notes:

1. Make sure to compact the database first, to avoid revealing table links that have already been deleted.

2. Grouping on the first 255 characters is required for Access 97, but not later versions, since [Database] is a memo data type. (Contributed by Doug Steele).

3. The criteria, WHERE (MsysObjects.Type)<>9, is used to filter out any table constraints created with ADO. (Contributed by Dirk Goldgar).

Appending Records (contributed in newsgroup post by Bob Hairgrove)
The syntax for INSERT INTO would be one of the following: 
(a) INSERT INTO [some table] (<list of columns>) VALUES (<list of values>); 

(b) INSERT INTO [some table] (<list of columns>) SELECT <column names> FROM [another table] WHERE ...

Splitting a database

    http://www.accessmvp.com/JConrad/accessjunkie/splitting.html
RGB Color Codes

    http://www.rapidtables.com/web/color/RGB_Color.htm
Proper Names (Contributed by John Vinson)

Private Sub txtLastName_AfterUpdate()
' Check to see if the name was entered in all lower case
' If so, convert it to Proper Case; if not, leave it alone

 

     If StrComp(Me.txtLastName, LCase(Me.txtLastName), 0) = 0 Then
          Me.txtLastName = StrConv(Me.txtLastName, vbProperCase)
     End If

 

End Sub
Example of Event Procedure With Built-in Delay (Contributed by Brent Spaulding)

Dim dtTimerExpired As Date

  :

  :
If rst.AbsolutePosition Mod 5000 = 0 Then
    dtTimerExpired = DateAdd("s", 2, Now)
    Do Until Now > dtTimerExpired
        DoEvents
    Loop
End If
Finding a Hidden Control on a Form

Sometimes a control on a form cannot be found, because it is not within the viewable area.  Here is a technique for moving the control in form design view:
1. Press CTRL+G to open the Immediate window in the Visual Basic Editor. 

2. Type the following command in the Immediate window, and then press ENTER:


Forms("FormName").Controls.Item("ControlName").left = 100

Example:

  
Forms("frmLoans").Controls.Item("Box37").left = 100

Related KB article

    You Do Not See the Toolbox in Design View of a Form or a Report

    http://support.microsoft.com/kb/248059
Counting Rows

A few examples that use subqueries:

Add Row Counter
SELECT 

(SELECT COUNT(*) FROM Customers AS I WHERE I.CustomerID<=O.CustomerID) AS RowNum, O.*

FROM Customers AS O

ORDER BY O.CustomerID;
SELECT 

(SELECT COUNT(*) FROM MsysObjects AS I WHERE I.Id<=O.Id) AS RowNum, O.*

FROM MSysObjects AS O

ORDER BY O.Id;

Group Orders by Tens:

Note the use of the \ operator, ie. Orders.OrderID\10
From Access Help file: Used to divide two numbers and return an integer result.

SELECT (Select Count(*) FROM Orders AS O 

WHERE O.OrderID<Orders.OrderID)\10 AS The10Group, Orders.*

FROM Orders

ORDER BY Orders.OrderID;

Counting Item X of Y

http://groups.google.com/group/microsoft.public.access.modulesdaovba/browse_frm/thread/5a853c394c9253c4/f10210397b490643
I have created a recordset from my data of hospital patients whereby a patient ID is associated with a series of test results. In the user form navigation is made using the in-built Access navigation buttons. However, some patients have more than one set of results for the same test. The user just sees a second (or third etc.) record where the patient ID is the same but one of the five tests has a different result. In order to make it clear to the user I would like to display (in a text box next to the ID field) an "X of Y" message for that particular PatID, independant of the Access nav buttons. I have tried various DAO recordset techniques, but my skills are not good enough yet.

Answer posted by John Nurick:

I don't see why you need recordset operations for this: you can just use calculated fields in a query to return the "X" and "Y" for each record. Here's an example that works in the Northwind sample database (ItemSeq is X, ItemCount is Y):

SELECT 

   (SELECT COUNT(C.OrderID) 

      FROM [Order Details] AS C 

      WHERE C.OrderID = A.OrderID 

        AND C.ProductID <= A.ProductID) AS ItemSeq, 

   (SELECT COUNT(D.OrderID)

      FROM [Order Details] AS D

      WHERE D.OrderID = A.OrderID) AS ItemCount,

    A.OrderID, 

    A.ProductID, 

    A.UnitPrice, 

    A.Quantity 

  FROM [Order Details] AS A 

  ORDER BY A.OrderID, A.ProductID;

Note: When you view the above query in design view, the hard returns will hide portions of each Field. You can unhide this by using the arrow key and the backspace key.

Retrieving all records for previous month
SELECT *

FROM Orders
WHERE OrderDate >= DateSerial(Year(Date()), Month(Date())-1, 1)

AND OrderDate < DateSerial(Year(Date()), Month(Date()), 1)
Retrieving all records for current month
SELECT *

FROM Orders

WHERE OrderDate >= DateSerial(Year(Date()), Month(Date()), 1)
AND OrderDate < DateSerial(Year(Date()), Month(Date())+1, 1)
Determining first (Monday, Tuesday, Wednesday, etc.) of current week
Examples shown for first Monday of week:

Method 1 (Contributed by Duane Hookom)

    =DateAdd("d",Choose(Weekday(Date()), 1,0,0,0,0,0,2), Date())

Method 2 (Contributed by Dick Darvis)

    =Date - (Weekday(Date) - 2) ())

Running parameter queries from code
This example is for a parameter query that gets it’s parameters from an open form, ie.
=[Forms]![FormName]![ControlName]
Function RunParamQuery()

On Error GoTo ProcError

Dim db As DAO.Database

Dim rs As DAO.Recordset

Dim qdf As DAO.QueryDef

Dim prm As DAO.Parameter

Set db = CurrentDb

Set qdf = db.QueryDefs("ParameterQueryName")

For Each prm In qdf.Parameters

prm.Value = Eval(prm.Name)

Next prm

Set rs = qdf.OpenRecordset(dbOpenDynaset)

With rs
Do Until (.BOF Or .EOF) = True

:

:

Loop

End with

ExitProc:

‘Cleanup

On Error Resume Next ‘( Note: Will fail in .mdb if Break On All Errors is set.

qdf.Close: Set qdf = Nothing

rs.Close: Set rs = Nothing

db.Close: Set db = Nothing

Exit Function

ProcError:

MsgBox "Error " & Err.Number & ": " & Err.Description, _

          vbCritical, "Error in RunParamQuery Function..."

Resume ExitProc

Resume

End Function
JET SQL Reference

The Jet 4.0 SQL Reference is on your hard drive in the following location, if you installed MS Office in the default directories:  "C:\Program Files\Common Files\Microsoft Shared\OFFICE11\1033\JETSQL40.CHM"

For more insight on using DDL for Jet 4.0 (and a few more examples), read the SQL Server BOL (Books Online) 

Two good reasons to isolate memo, OLE Object & Hyperlink data types
    (ACC2000:) Table Corruption After Referential Integrity Checks
    http://support.microsoft.com/kb/296389
and

"A limitation to record-level locking is that users will not be notified when another user is locking the record.” “Also, record-level locking is not enabled for Memo data types."
Source: http://support.microsoft.com/kb/275561, under the title: "Record-level locking".
Retrieving Last Identity (Autonumber) Value Inserted

' Based on code posted by Allen Browne
' http://groups.google.com/group/microsoft.public.access.queries/msg/764193b98c2d20ef
' Full thread available here. 

Option Compare Database

Option Explicit

Function ShowIdentity() As Variant

On Error GoTo ProcError

Dim db As DAO.Database

Dim rs As DAO.Recordset

   Set db = DBEngine(0)(0)

   'Note: For this example in Northwind, the FirstName and LastName fields are required fields.

   db.Execute "INSERT INTO Employees ( LastName, FirstName ) " _

                  & "SELECT 'Doin', 'Nuffin';"

   Set rs = db.OpenRecordset("SELECT @@IDENTITY AS LastID;")

   ShowIdentity = rs!LastID

ExitProc:

   'Cleanup

   If Not rs Is Nothing Then

      rs.Close: Set rs = Nothing

   End If

   Set db = Nothing

   Exit Function

ProcError:

   MsgBox "Error " & Err.Number & ": " & Err.Description, _

          vbCritical, "Error in ShowIdentity Function..."

   Resume ExitProc

End Function 
Synchronized combo boxes
    Limit content of combo/list boxes

    http://www.mvps.org/access/forms/frm0028.htm
    How to synchronize two combo boxes on a form in Access 2002 or in Access 2003

    http://support.microsoft.com/kb/289670
    Basing one combo box on another

    http://office.microsoft.com/en-us/access/HA011730581033.aspx
Synchronized combo boxes on Continuous form
    Tip #16: Data in a combo box control on a continuous form/datasheet disappears

    http://www.fmsinc.com/free/newtips/access/accesstip16.asp
http://www.rogersaccesslibrary.com/download3.asp?SampleName=CascadingComboInSubform.mdb
Contributed by Sandra Daigle (3/10/2006 in microsoft.public.access):

http://groups.google.com/group/microsoft.public.access/browse_frm/thread/e033253ffea2b09f/718a00e1deccf74f?
“…the problem you are seeing is due to the fact that there is really only one combo control - it is just displayed multiple times. So whatever you have for current rowsource will apply to all rows. This makes it difficult to use synchronized combos on continuous forms. However, there is a fairly easy workaround. To create the effect of a synchronized combo in a continuous form create another textbox control, include the display column of the combo in the Recordsource query of the form (join the foreign table and drag in the column). Position and size the new textbox so that you can place it directly over the combo box allowing only the down-arrow portion of the combo to show.

Create a GotFocus event for the textbox that only does a SetFocus to the combo.

This will create the effect that you are wanting - the correct display value will always show even though the value itself might not be fit the criteria that is in effect based on the current record.

Here's a KB Article that explains the problem

    (ACC2000:) Combo Box in Continuous Form Shows Incorrect Data

    http://support.microsoft.com/kb/208866
Here's a link to my sample database that offers several different alternatives for displaying this type of data including the technique described above:

    http://www.accessmvp.com/SDaigle/index.htm
See Access MVP Doug Steele's February, 2006 "Access Answers" column in Pinnacle Publication's "Smart Access". You can download the column (and sample database) for free at:

   http://www.accessmvp.com/DJSteele/SmartAccess.html

His discussion of this issue begins at the bottom of page 4 of the .pdf document.

Macros
In Access 2003 and all prior versions, one cannot trap for errors and handle them gracefully when using macros. Any errors that occur will cause a really ugly macro error dialog to be presented to your users. The newest version of Access, Access 2007 allows for error trapping, so macros are more appropriate to consider using for Access applications created with Access 2007.

Consider the following quote:

From: "Inside Relational Databases, 2nd Edition, by Mark Whitehorn and Bill Marklyn, published by Springer, p 151

"Macros offer the next level down, extending the functionality of the GUI. Macros are still limited, however, and do not provide anything like the enormous flexibility of a programming language. Both the macro and the programming languages take some effort to learn and, surprisingly, often require relatively different skills; in other words, a good working knowledge of macros may not make it much easier to convert to using the programming language. Perhaps even more surprisingly, I do not believe that programming is fundamentally more difficult to learn. Macros are easier to use but not by orders of magnitude."

"If you are new to RDBMSs, I suggest (with as much deference as possible) that you may well not be in a position to judge whether you need macros or programming. In that case, my advice is clear. Unless you are sure that your needs really are simple, don't bother learning to use macros. Once you find that you need more than the GUI offers, go straight to the programming language. In this way you avoid the pain of climbing one learning curve only to discover that the view from the top is unsatisfactory and another climb awaits you."
Trapping for Error 3022
Error 3022 is a JET error (not a VBA error) that occurs when a person attempts to enter a duplicate record in a field (or fields) that has a unique index set. The resulting error message is not very user friendly:
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Note: If you have previously added an application title (Tools > Startup), then the title will be displayed in place of “Microsoft Office Access”.  To present a more user-friendly error message, use the following code in the form or subform that is being used when the error is generated:

Private Sub Form_Error(DataErr As Integer, Response As Integer)

    Select Case DataErr

    Case 3022

        MsgBox "This item has already been added." & vbCrLf & _

               "You cannot create duplicates.", _

                vbOKOnly + vbInformation, "Item Already Added..."

        Me.Undo

        Response = acDataErrContinue

    Case Else

        Response = acDataErrDisplay

    End Select

End Sub

The resulting error message will look like this:
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( See the next page for an example of combining two error checks in the Form_Error event procedure for the Northwind Order Details subform. 

An example of combining two error checks using the Form_Error event procedure with the Northwind Order Details form. The first check verifies that a parent record has been added. The second check prevents a product from being selected twice on the same order:

Private Sub Form_Error(DataErr As Integer, Response As Integer)

' Errors can occur here if the user has not already selected a customer for

' this order on the main form. If there is an error and Orders!BillTo is Null

' inform the user and cancel the entry made in the subform.
If DataErr > 0 Then

  If IsNull(Me.Parent!CustomerID) Then

     MsgBox "Select a Customer to bill to before entering order details info."

         Me.Undo

   'Set focus to first visible control.
         Me.Parent!CustomerID.SetFocus

         Response = acDataErrContinue

      Else

         If DataErr = 3022 Then

            MsgBox "This item has already been added." & vbCrLf & _

                   "You cannot create duplicates.", _

                    vbOKOnly + vbInformation, "Item Already Added..."

            Me.Undo

            Response = acDataErrContinue

         Else

            Response = acDataErrDisplay

         End If

      End If

   End If

End Sub

Linked Excel Data

For “legal issues”, one can no longer update data in a linked Excel spreadsheet, in Access 2002 (SP-3) or 2003 (SP-2), or Access 2007 (Microsoft lost a lawsuit):

You cannot change, add, or delete data in tables that are linked to an Excel workbook in Office Access 2007, Office Access 2003, or Access 2002
http://support.microsoft.com/kb/904953
The two methods offered in the above KB article are rather lame: make your changes in the Excel spreadsheet, or import the data, make your changes, and then export back to .xls. However, you can use a SELECT query as follows:

SELECT *
FROM [excel 8.0;imex=0;DATABASE= Full path to Excel File].NamedRange; 

or

SELECT Field1, Field2, Field3…
FROM [excel 8.0;imex=0;DATABASE= Full path to Excel File].NamedRange; 

where NamedRange is a previously established named range within the spreadsheet, and Field1, Field2, Field3 are valid header rows within the named range. The important part is that imex=0 is included, as indicated above. Without this parameter, the query will be read only. 

Note: This method does not allow deleting records in the spreadsheet.

Upsize to SQL Server?

If you decide that you really need to migrate, you should obtain a copy of the book titled "Microsoft Access Developer's Guide to SQL Server", written by Mary Chipman and Andy Baron (SAMS Publishing). Here is a link to the book at Amazon.com:
       http://www.amazon.com/dp/0672319446
Early in the book (page 6) the authors write: 

<Begin Quote>

"Many people think that upsizing from the Jet database engine to SQL Server is a universal panacea for whatever is ailing their Access databases. It's not. In fact, just the opposite is usually true. If your Access application is a dog, then most likely it will still be a dog after you upsize it to SQL Server--perhaps an even bigger, uglier, shaggier dog! Even a well-designed Jet database often won't run any faster after the tables are upsized to SQL Server if you are using the same data access methods you used for your Access database. In order to successfully convert your Access database, you have to be clear about why it needs to be upsized, and you need to understand how to take advantage of the strengths of SQL Server by reworking the data access elements of your Access application."

</End Quote> 

Slow Performance Complaints with SQL Server

Here are some things to try. These suggestions come from a presentation that Access MVP Armen Stein gave to the Pacific Northwest Access Developer's Group.

Add SQL Server TimeStamp fields to every table 
Access row locking normally compares EVERY field to the last read value to see if anyone else has changed the record. Not only is this slow, but for some floating point fields, the comparison fails and Access always thinks the record has been changed by “another user”. Add a TimeStamp field in every table. Access will use it to make the comparison. More info. on timestamps:

     You may receive write conflict errors when you update records of a linked SQL Server table
     http://support.microsoft.com/kb/280730
     Linked SQL Server Table Cannot Be Updated

   http://support.microsoft.com/kb/208842
Common performance bottlenecks 
Updateable detail screens using large recordsets (use an index screen to open one record at a time) 
Combo boxes on large rowsources 
Reports with complex queries 
Index screens with complex queries 
Data lookup functions (Dlookup, Dsum, Dcount, etc.)

Use Passthrough Queries 
To build:  Query > SQL Specific > Passthrough 
Very fast, but not updateable


Use SQL Server syntax (% instead of *, etc.) 
Can be altered in code using the QueryDef.SQL property 
Can be based on views or stored procedures for even more speed and complexity 
Doesn’t work for subforms/subreports with master/child fields 
Cheat!  Use the Access or SQL Designer to get the syntax, then paste it into the passthrough
Use NOLOCK 
Even for non-updateable index forms, SQL Server will sometimes place locks anyway.  These can cause updates to fail and poor performance. To prevent these, add (NOLOCK) to your passthrough queries. It goes right after the FROM clause, like this:

Select * from Products (NOLOCK)

Bonus Trick 1 
Performance issue with complex passthroughs 
Access forms and reports are not supposed to evaluate the recordset until AFTER the On Open event. However, we have seen that it does, probably to get the column definitions of the recordset.  This can cause a serious delay. To avoid this, set the Where Clause of the passthrough query to “WHERE 1 = 0” when the form or report closes. The next time, the object will open much faster. Then set the Where clause normally.
    How to store SQL database login IDs and passwords locally (or disallow storing this data)

    http://support.microsoft.com/kb/209502
    You may receive write conflict errors when you update records of a linked SQL Server table (in Access 2000)
     http://support.microsoft.com/kb/280730

Note: Parentheses around "in Access 2000", as this same issue very likely applies to all versions of Access and SQL Server.

A SQL Server data type of Timestamp (RowVersion in SQL Server 2008) is not a normal date/time value; it is a unique identifier that SQL Server will generate without any action needed on your part. However, if you are going to use a Yes/No field in an Access application, you should set a default value of either zero (=false and is unchecked) or -1 (=true and is checked). 

Many Access developers refuse to use Yes/No fields, among them Access MVP Allen Browne.

    Why I stopped using Yes/No fields
    http://allenbrowne.com/NoYesNo.html

Access MVP Armen Stein has some good material available at his download site, including the pros and cons of adding Timestamp fields:

     http://www.jstreettech.com/downloads.aspx
     ---> See "The Best of Both Worlds: Access-SQL Server Optimization".

Some MSDN articles on TimeStamps

http://msdn.microsoft.com/en-us/library/ms182776(SQL.90).aspx


 

This is the info on the new RowVersion type, which is again is mostly the same as TimeStamp:

http://msdn.microsoft.com/en-us/library/ms182776.aspx


 

Replication
This is the scenario that replication was designed to handle. You should only try implementing replication on a *copy* of your database, not on the original. I am not a replication expert, but I do advise you to download a copy of the replication white paper from Microsoft:

ACC2000: Jet 4.0 Replication White Papers Available in MSDN Online Library

      http://support.microsoft.com/kb/190766
Here is a KB article that may also be helpful:

      ACC2000: How to Make a Database Replicable

      http://support.microsoft.com/kb/208774
Although both titles include "ACC2000", the information should be equally valid for Access 2002 and 2003. I would also head on over to Michael Kaplan's web site and read everything you can find on replication:

       http://www.trigeminal.com/usenet/usenet.asp?1033
Database Un-replicator: http://www.trigeminal.com/lang/1033/utility.asp?ItemID=11#11
    Merge a picture from an Access database into Word
    (See Special Merges section)

     http://homepage.swissonline.ch/cindymeister/MergFram.htm
Posted by Trevor Best on comp.databases.ms-access

Date: 2004-11-28 02:42:02 PST

I do name them like that but sometimes can forget to in a hurry, so I use .ControlType to determine what it is, another handy tip is do something like:

Dim ctl As TextBox

for each ctl in me.controls

   if ctl.ControlType = acTextBox then

     ctl.<all textbox properties drop down here>

   end if

next

then go back and change the Dim to "Control", but it does require you remember to go back and change it but then it does kind of remind you if you don't ;-)

Late Bound code for Outlook to send several file attachments

http://groups.google.com/group/microsoft.public.access/browse_frm/thread/544e8606046f3da9/12cec9d74e4ea953
Option Compare Database

Option Explicit

Public Function SendMail(strRecipients As String, strSubject As String, _

       Optional strBody As String, Optional strFilePath As String, _

       Optional strFileExtension As String, Optional blnSend As Boolean = False) As String

On Error GoTo ProcError

'   Written by Tom Wickerath, May 7, 2006. Last updated: November 19, 2010.

'   Inputs:

'   strRecipients:

Required. Semicolon delimited string of recipients.

'   strSubject:


Required. Message subject.

'   strBody:



Optional. Body of the message.

'   strFilePath:


Optional. Valid path containing files to attach.

'   strFileExtension:
Optional. Allows one to send a particular file type.

'   blnSend:            

Optional. Send message immediately (True) or display for editing (False = default).

'                                 


    Note: A setting of True will produce the Outlook Security prompt.

'

'   Returns a string to indicate success or failure.

'

' Notes:

'   1.) An invalid path will result in a message with no attached files.

'   2.) This is late bound code. It does not require a reference to the

'        "Microsoft Outlook {Version X.X} Object Library". However, there is also no

'         Intellisense to help you with editing the VBA code.

'

' Usage examples from Immediate Window:

'  ?SendMail("me@1.net;you@2.com", "Testing...", _

             "This is a test of the emergency broadcast system.", False)

'

'   Message with all .snp files in the C:\Temp folder:

'   ?SendMail("me@1.net;you@2.com", "Reports",,"C:\Temp", "*.snp", False)

'

'   Message with all files in the C:\Temp folder:

'   ?SendMail("me@1.net;you@2.com", "Reports","My message","C:\Temp", False)

'Use for Late Binding

Dim myObject As Object

Dim myItem As Object

'Use this for Early Binding.

‘Note: Requires a checked reference to the Microsoft Outlook {version} Object Library

   'Dim myObject As Outlook.Application

   'Dim myItem As Outlook.MailItem

Dim strFullPath As String

Dim strFileName As String

Dim strAttachPath As Variant

Dim intAttachments As Integer

Set myObject = CreateObject("Outlook.Application")

Set myItem = myObject.CreateItem(0)
‘Continued on next page

    With myItem

        .Subject = strSubject

        .To = strRecipients

        If Len(Trim(strBody)) > 0 Then

            .Body = strBody

        End If

        If Len(Trim(strFileExtension)) = 0 Then

            strFileExtension = "*.*"

        End If

        If Len(strFilePath) > 0 Then

            strFullPath = strFilePath & "\" & strFileExtension

            If Len(Trim(strFullPath)) > 0 Then  'An optional path was included
                strFileName = Dir(strFullPath)

                Do Until strFileName = ""

                    intAttachments = intAttachments + 1

                    strAttachPath = (strFilePath & "\" & strFileName)

                    .Attachments.Add (strAttachPath)

                    ' Debug.Print strAttachPath

                    strFileName = Dir()

                Loop

            End If

        End If

      Select Case blnSend

         Case True

            'Use the .Send method to send the message immediately. This will

            'produce the Outlook Security dialog asking for user permission.

            'If Outlook is running, message will be sent immediately. If Outlook

            'is not running, the message will be placed in the Outbox folder.

            .Send

            SendMail = "Message placed in outbox or sent with " _

                      & intAttachments & " file attachment(s)."

         Case False 'Default

            'Use the .Display method to open the message for editing.

            'This method does not produce the annoying Outlook Security method.

            .Display

            SendMail = "Message created with " _

                      & intAttachments & " file attachment(s)."

      End Select

    End With
ExitProc:

    ‘Cleanup

    On Error Resume Next
    Set myItem = Nothing 
    Set myObject = Nothing
    Exit Function 
ProcError: 
    MsgBox "Error " & Err.Number & ": " & Err.Description, _ 
                   vbCritical, "Error in SendMail Function..." 
    SendMail = "A problem was encountered attempting to automate Outlook." 
    Resume ExitProc 
    Resume 
End Function
Send files to Recycle Bin
Ref.: Message #6 posted by Rick Brandt
http://groups.google.com/group/microsoft.public.access.modulesdaovba/browse_frm/thread/d62e934d975cf59b/b3efa81b7b5370dd
 

Option Compare Database 
Option Explicit 

'Code courtesy of Chuck Grimsby
Private Type SHFILEOPSTRUCT

    hWnd As Long

    wFunc As Long

    pFrom As String

    pTo As String

    fFlags As Integer

    fAnyOperationsAborted As Boolean

    hNameMappings As Long

    lpszProgressTitle As String

End Type

Private Declare Function SHFileOperation Lib "shell32.dll" Alias _

    "SHFileOperationA" (lpFileOp As SHFILEOPSTRUCT) As Long

Private Const FO_DELETE = &H3

Private Const FOF_ALLOWUNDO = &H40

Private Const FOF_NOCONFIRMATION = &H10

Private Const FOF_SILENT = &H4

Public Sub Recycle(File As String, Optional Confirm As Boolean = False, _

                   Optional SilentOnError As Boolean = True)

Dim FileOperation As SHFILEOPSTRUCT

Dim lReturn As Long

Dim sFileToDelete As String

Dim lFlags As Integer

'Set File to delete.

sFileToDelete = Trim(File) & vbNullChar

'Set flags.

lFlags = FOF_ALLOWUNDO

   If Not Confirm Then

      lFlags = lFlags Or FOF_NOCONFIRMATION

   End If
   If SilentOnError Then

      lFlags = lFlags Or FOF_SILENT

   End If

   With FileOperation

      .wFunc = FO_DELETE

      .pFrom = sFileToDelete

      .fFlags = lFlags

   End With

   '  Send to recycle bin.

   lReturn = SHFileOperation(FileOperation)

End Sub
Convert decimal numbers to fractions
Public Function FractionIt(dblNumIn As Double) As String

 '===================================================

 ' Name:  FractionIt

 ' Purpose: Converts a double into a string representing a rounded fraction

 ' Inputs: dblNumIn As Double

 ' Returns: String

 ' Author: Arvin Meyer

 ' Date: Revised - 6/22/2001

 ' Comment: Rounds down from 1/64 over

 '========================================================

On Error GoTo Err_FractionIt

Dim strFrac As String

Dim strSign As String

Dim strWholeNum As String

Dim dblRem As Double

    If dblNumIn < 0 Then

        strSign = "-"

        dblNumIn = dblNumIn * -1

    Else

        strSign = " "

    End If

    strWholeNum = Fix([dblNumIn])

    dblRem = [dblNumIn] - [strWholeNum]

Select Case dblRem

    Case 0

        strFrac = ""

    Case Is < 0.140625  '  9/64" > dblNumIn > 0         returns: 1/8"
        strFrac = "1/8"

    Case Is < 0.265625  ' 17/64" > dblNumIn >= 9/64"   returns: 1/4"
        strFrac = "1/4"

    Case Is < 0.390625  ' 25/64" > dblNumIn >= 17/64"  returns: 3/8"
        strFrac = "3/8"

    Case Is < 0.515625  ' 33/64" > dblNumIn >= 25/64"  returns: 1/2"
        strFrac = "1/2"

    Case Is < 0.640625  ' 41/64" > dblNumIn >= 33/64"  returns: 5/8"
        strFrac = "5/8"

    Case Is < 0.765625  ' 49/64" > dblNumIn >= 41/64"  returns: 3/4"
        strFrac = "3/4"

    Case Is < 0.890625  ' 57/64" > dblNumIn >= 49/64"  returns: 7/8"
        strFrac = "7/8"

    Case Is < 1                ' 65/64" > dblNumIn >= 57/64"  returns: 1"

        strFrac = "1"

End Select
If strFrac = "1" Then

    FractionIt = strSign & (strWholeNum + 1)

Else

    FractionIt = strSign & strWholeNum & "-" & strFrac

End If

Exit_FractionIt:

    Exit Function

Err_FractionIt:

    Select Case Err

    Case 0

    Case Else

        MsgBox Err.Description

        Resume Exit_FractionIt

    End Select

End Function
Rounding Numbers

Question posted to the newsgroup: Microsoft.Public.Access

If you put a text box in any form or report and enter =Round((5/4),1) you will get 1.2.  We all can see the actual answer is 1.25 therefore it should round to 1.3, but it doesn't. Has anyone found a workaround for this? I have a report with about a hundred calculations in it - that is currently unusable because things are not always rounding correctly.

Answers

1.) By Allen Browne

The built-in rounding rounds towards the nearest even number (called banker's rounding), so 1.25 rounds down towards 1.2, but 1.35 round up towards 1.4. 

If you do not want that, you can create your own rounding function. There is one by Ken Getz you can copy in this link: 
    http://www.mvps.org/access/modules/mdl0054.htm 
Be sure to rename the function if you are using it in Access 2000 or later, so it does not fight with the inbuilt Round() function. 

2.) By Wayne Morgan

It is rounding "correctly" (i.e. as designed). There is more than one way to round. While most folks round up at .5, this causes an imbalance (5 numbers, 5-9 round up and 4 numbers, 1-4 round down). So there is another type of rounding commonly known as "bankers rounding" or "scientific rounding" that rounds .5 to the nearest even number. This way, you round up half the time and round down half the time, reducing the skewing of your data. However, it only rounds .5 this way. If there are additional decimal places such as 1.2500001, this is greater than .5 and will round to 1.3. You have to be exactly at .5 to round to the nearest even number.

To get the more conventional rounding, you need to create your own function. Give it a different name, such as MyRound.

Example:

Public Function MyRound(dblNumberToRound As Double, _

                     intRoundTo As Integer) As Double

Dim dblResult As Double

Dim intFactor As Integer

intFactor = 10 ^ (-intRoundTo)

dblResult = dblNumberToRound * intFactor

dblResult = Int(dblResult + 0.5)

MyRound = dblResult / intFactor

End Function

The math is done in more than one step to reduce floating point errors that will give an undesired result. Using the value you mentioned, this would be called as

      =MyRound((5/4),-1)

